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Technical Bulletin 
February 2005 

Creating and Distributing ICC Profiles 
for Use with Wasatch SoftRIP 

 

Getting Started 
This document will teach you how to create ICC profiles using a combination of Wasatch SoftRIP and third party 
color profiling software package such as Color Blind, Monaco, Profile Maker (Gretag), etc.  We recommend that 
you allocate a minimum of 20 feet of media to produce each profile. 
 
Although this document provides a detailed discussion of how to create profiles using SoftRIP, you will also need 
to refer to your profile making software manual for intermediate steps where noted.  Further, it will provide 
instructions for importing the profile and printing a final test of your new Imaging Configuration.  It will also cover 
processes for collecting, distributing and installing profiles at a remote site. 
 
An Important Note Before You Start 
Always calibrate your printer before profiling. Follow the steps outlined in the printer’s user manual for printer 
calibration.  In this case, "calibration" refers to setup processes performed on the printer and are specific to that 
printer model (it's not the same as the SoftRIP Calibration described below). Calibration processes include media 
feed calibration, bi-directional calibration, head height, media thickness, head speed and any other calibrations 
prescribed by the printer manufacture.  All calibrations should be redone after loading a new substrate.  These 
settings should remain constant while profiling. In short, the printer should be in its “optimal operating condition”. 
  
Step 1: Setup Configuration 
To begin, select your Printer Model and Imaging Configuration on the Setup screen. Once you have made these 
selections, DO NOT change any settings during the profiling process, changes to these settings will 
require starting over.  Proceed as follows: 

 

• Launch Wasatch SoftRIP and select “Setup” from the Print menu. 

 
• On the Setup screen, check Annotate Prints and the Annotation Details window will open. We recommend 

you turn on “Printer”, “Imaging Configuration”, “Date/Time”, and “Comment” so each image will be 
printed with your settings and additional comments.  

Updated Updated 
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• Select your printer model in the Printer Model window.  Select “none” as the Imaging Configuration (IC) 
and click on the "Edit" button. This will launch the Imaging Configuration screen. 

• On the Imaging Configuration screen, click the “Properties” button. This will launch a control screen that 
provides additional settings and/or print modes (i.e. various resolutions, ink modes etc.) for your specific 
printer.  Every printer has a different set of printer properties.   Determine your intended output 
configuration now and select the Print Parameters including: Print Direction, Print Quality, Dot Volume, 
Ink Type, # of passes, etc.  Again, it is extremely important that all printer and halftone 
settings, inks, media, print modes and other factors that affect the print condition be set 
prior to beginning the linearization process, and that you do not change them at all during 
the profiling process.  When you have completed your settings, click OK.  

• Back on the Imaging Configuration screen, click the “Edit Info” button and create a text file to record the 
properties you selected as part of your configuration.  This is especially helpful if you plan to distribute 
your final IC and is a good place to keep track of your notes as you build your IC. When you click “Edit 
Info”, your default text editor will open for you to enter notes.  When you’re done, select "Save" from the 
File menu and your info.txt file will be linked to the Imaging Configuration name you select. This 
information will be available to anyone who clicks on the “Info” button later. You can also edit this file at 
any time.  After saving, exit the text editor and you will be returned to the Imaging Configuration screen. 

 
Step 2: Color Transforms Configuration 

• Click on the “Color Transform” button to launch the Color Transform screen. This is your master color 
flowchart screen.  You will notice that all color data is cleared and set to none or default (as a result of 
setting IC to none). In the lower right hand corner of the screen you will see that Precision Stochastic 
Screens is displayed as the default halftone method. For most applications, “Precision Stochastic Screens” 
is the preferred halftone method, and stock Wasatch ICs are created using them. However, you may 
choose other halftone methods from this window on which to build a profile. Whatever halftone method 
you choose will be incorporated into the IC you create. Changing it later will invalidate the Imaging 
Configuration.  (Note: this technical document only covers processes for profiling with Precision 
Stochastic Screens.  Profiling steps will vary for other halftone methods). 

• In the “ICC Input Profile” column on the left side of the Color Transforms screen, you should now see all 
four input color spaces set to “System Default”.  You will also see that the default rendering intent of 
“Perceptual” has been set.   

• Click OK to exit the Color Transforms screen and click OK again to exit the Imaging Configuration Screen.  
A “Save As” window will launch prompting you to name your new Imaging Configuration.  We 
recommend naming your "in-progress" IC with a name like “Unlinearized-None”.  If you are making 
profiles in a production capacity you may want to avoid having many ambiguously named ICs by using 
more detail like “Unlinearized_None_resolution_inktype_media”.  Once you save the IC you will be 
returned to the Setup screen.   

 
Step 3: Test Prints 

• On the Setup screen, make the other non-color related selections required for printing. These settings 
include Physical Connection, Paper Width etc. Click OK and you are now ready to print your test prints. 

• In the File menu, select “Open” and then browse to select c:\psfiles\spectroscan_4color.ps or 
c:\psfiles\media.ps (Note: Exact location of the "psfiles" folder may vary depending on drive & folder to 
which it was assigned when SoftRIP was installed.  These files are automatically installed with SoftRIP. 
"Spectroscan_4color.ps" is a new test file that Wasatch began distributing with the June 7, 2004 SoftRIP 
Engineering Release).  Open each of these files and select “RIP and Print” to print the file. You will use it 
in the next section.   
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Step 4: Determine Ink Limiting 
• In this step, you may decide to perform an ink reduction to one or more channels. You may also decide 

to perform an ink limit, which is an adjustment to your total ink deposit. An ink reduction is intended to 
correct for individual ink channel or ink chemistry problems.  For ink over-saturation issues an ink limit 
should be applied. These are separate functions and are performed on different controls, as described 
further below.  

• INK REDUCTION: In the profiling process, ink reductions should be performed prior to setting ink limits. 
To determine if you need an ink reduction, examine the color patches on "spectroscan_4color.ps".  Ink 
reduction is performed for each channel, so look at the patches for each color individually.  Compare 
each color square with the one next to it.  Every square should be visibly different from its neighbors.  If 
two neighboring squares have no visible density difference, an ink reduction should be applied on that 
specific channel. Each test pattern moves from 100% to 0% in 6% increments.  No two patches should 
look like they have the same density.  Locate the two patches with the greatest percentage that are 
visibly different and set an ink reduction equal to the percentage of the more dense patch. Remember 
that ink reductions affect the entire color gamut so they should be used sparingly. 

 

• If you decide you need to do an individual ink channel reduction, use the Halftone Properties controls on 
the Color Transforms screen.  On the right hand side of the Color Transforms screen you’ll see that the 
Halftone Method is set to default on “Precision Stochastic Screens”.  Click on “Halftone Properties” to 
launch the screen below. 

 

• Use the four sliding controls at the bottom of the Precision Stochastic Screens screen.  These controls 
may be used to set ink reductions for any channel individually or for all channels together.  After setting 
an ink reduction, re-save the IC (named “Unlinearized-None” or similar) and add notes on the change 
applied using “Edit Info” as in step 1.)   

• INK LIMITS: Now review your print of "media.ps" to determine if you need a Total Percent Ink Limit in 
addition to the per channel reduction.  On "media.ps", examine the center area, which consists of three 
parts.  
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- The first line is a step pattern from 0% ink to 400% ink consisting of composite black squares.  As 
the maximum ink limit, select the highest percentage dry patch that does not have artifacts in the 
ink.   

- The second line is a series of open boxes also consisting of composite blacks.  Check this area for 
media bleed or over spray.  It also allows a resolution check.  

- The third line is a group of 7 colors consisting of primary inks and one CMY black. The CMY black 
may show excessive bleeding or artifacts due to the “inks mixing” where the first two tests above do 
not. This is why it’s very important to review this patch.  Check this area for individual ink retention 
issues. 

Note: Be aware of the amount of drying time needed before the patches can be handled in this 
step and whether you need to do any further ink limiting. This is an individual preference and is 
determined by what drying time would normally be acceptable in a production environment. 

• Again, if there are any issues with any/all of these test patterns you’ll need to set an ink limit or return to 
the ink reduction step to apply stronger reductions.  If you choose to set an ink limit, return to the Color 
Transforms screen.  Above the halftone settings on the right side you see the Ink Limit (Total Percent) 
box.  Enter the percent of your Ink Limit.  Click OK to exit the Color Transforms screen, OK to exit the 
Imaging Configuration screen and once again save your “unlinearized” IC. 

 
Step 5: Test Print—Reprint media.ps 

• Reprint "media.ps" to check for any additional ink reductions or ink limits that may be required. All 
squares should have good retention, show no artifacts, and show no bleed problems.  

• Note: if you have set a total percent ink reduction, all patches above the percent set will be identical.  So, 
for example, if you set your Ink Limit (Total Percent) to 325% you will see that the patches for 325, 350, 
375, and 400 will look the same.  

• If you are still having ink retention issues you have some options.  Depending on the printer model you 
are trying to profile there are other options used for limiting ink. For example, you can choose a different 
ink set, lower the resolution, or change to a dry mode (if available). However, remember that you must 
repeat the previous profiling steps if you make any changes to the setup configuration. 

 
Step 6: Linearize (Calibrate) the Printer 

• Open the appropriate linearization file the matches your spectrophotometer and printing scenario, such 
as c:\wwrip\psfiles\DTP41.ps or c:\wwrip\psfiles\DTP32.ps).  You can find more information on which file 
is right to use for your spectrophotometer in SoftRIP online help—Densitometers section.   

• RIP and print the selected linearization test pattern.  Return to the Halftone Properties screen as you did 
in Step 4 and click the Calibration button to launch the Calibration screen shown below. 
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• Use the “Options” menu on this screen to choose between performing a density linearization (default) 
and a dot linearization. Your choice should be driven by your output type and more importantly by the 
expectations of your ICC profiling software.  You may need to test each setting to determine which 
provides best results with your profiling package.  

• Select your densitometry hardware from the “Densitometer” menu.  You will receive device-specific 
instructions for reading the linearization patches. Once you have followed the on-screen instructions and 
read the strips, click OK to exit densitometer input. 

 

• You will see the resulting data in the Calibration Curve display, which will look similar to the curves shown 
above.  Click on OK as many times as is necessary to return to the Imaging Configuration screen.  You 
must exit all screens by clicking OK instead of Cancel, or your data will be lost.  When you click OK on the 
Imaging Configuration screen you will be asked to save your Configuration.  Name your Configuration so 
that it is identified as your original linearization data (such as Halftone_Linearization_Original_Data). 

 
Step 7: Confirm Linearization 

• Reprint the same linearization test pattern from step 6 using your new Imaging Configuration 
(Halftone_Linearization_Original_Data or whatever you named it).  By reading these patches, you can 
check your linearization to ensure that your original data is good.  Follow the steps above to access the 
Calibration screen (Print-Setup-Edit-Color Transforms-Calibration.)  Note: this is taking you to the 
Calibration window straight off Color Transforms—NOT the Halftone properties calibration window.  

• Use the “Options” menu to select the same linearization type used in the original linearization.  Select 
your hardware from the “Densitometer” menu and again follow the steps to read the linearization 
patches.  Click OK to return to the Calibration screen.  
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• Now the curves shown in the Calibration Curve display should look nearly linear (straight on the 
diagonal).  If your curves are linear, you now want to use the Cancel button to back out of all 
screens and return to the main screen. Don't use OK. It is very important that you use Cancel to 
exit; if you use OK you will write over your data and invalidate the true, original linearization.   

• If your linearization confirmation curves still have large bumps or fall away sharply from the center line, 
you’ll need to perform a new linearization.  To do this you must first clear out your linearization check by 
using cancel to exit the main calibration screen.  Then go to halftone properties, click calibration, and 
select “clear all” to remove the original linearization curves.  Use OK to back out of the Halftone 
Calibration, Precision Stochastic Screens Halftone Properties, Color Transforms, and Imaging 
Configuration screens and save your Imaging Configuration as a new name (such as 
Halftone_Linearization_Second_Attempt) and click OK to save.  Return to step 6 to perform a new 
linearization and repeat the steps to confirm linearization.  If the curves still have bumps or fall away 
from the centerline after the second confirmation, you should reconsider your ink limit and ink reduction 
settings.  You may want to speak with a Wasatch technician for guidance. 

 
Step 8: Print Profile Target 

• Your profiling software (such as Monaco or Color Blind) that you are using will provide a standard set of 
patches that will need to be printed through SoftRIP and read with your spectrophotometer.   

• Open the file provided by your profiling software in SoftRIP.  Apply the newly created/last saved 
linearized Imaging Configuration such as “Halftone_Linearization_ Original_Data” or “Halftone 
Linearization_Original Data+Calibration_Linearization”.  Rip and Print the file.  

• Allow patches to dry if necessary and "read" the patches into your profiling software.  Save the generated 
ICC or ICM file in a location you can easily browse for importing into SoftRIP. 

 
Step 9: Import Profile 

• Once the profile has been generated from the profiling software you can import it into SoftRIP and match 
it up to the linearization by accessing the Color Transforms Screen (Print>Setup>Edit>Color Transforms). 

 

 

• In the middle section, you’ll see the “Output ICC Profile” section. It should still show “None” as the 
profile.  Browse for the correct “ICM” or “ICC” file in the directory you used for storing the profile from 
your profiling software.  The arrows on the Color Transform screen should turn green indicating that the 
color workflow is working correctly. 

• Click OK until you get to the “Save As” screen.  At this point, you want to save the Imaging Configuration 
under the final name you want your profile to have. We recommend using the “Resolution_Inkset_Media” 
naming convention to make it easy to find the Imaging Configuration later.  When you click OK, your 
Configuration will be saved. It can now be accessed in the Imaging Configuration drop down window on 
the Setup screen. 
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Step 10: Print Profile Test 

• With your new profile you may want to print a test file. Wasatch does not supply a file for you to use but 
we suggest you create one internally as a final standardized testing procedure. 

• This test file should be one in which the original color is standardized.  We recommend that you NOT use 
a customer file or a random color file as it will be difficult to locate color issues in these types of files.  
Rather, Wasatch recommends that you print a standard image you are familiar with.  It should have 
primary colors, secondary colors, and an image with details like faces, shadows, etc.  It should also have 
both CMYK and RGB components. 

• Be sure that all of your color and printer settings are consistent with the settings used when your profile 
was generated.  RIP and Print your test image. 

• Analyze the print for quality assurance in order to determine whether your new profile should pass or fail.   
Things to check for including: posterization, lizarding affects, turtling affects, bleeding, banding, patterns 
introduced by process, or any other abnormalities.  Also check the final print for saturation, and overall 
color.  Keeping in mind that different substrates look different, it is reasonable to ask, “Is this expected 
behavior for the media and resolution?”  

 
Step 11: Distribution (optional) 

• If you intend to distribute profiles you must be in accordance with the copyright statement of your 
profiling software.  

• We recommend that you distribute your new Imaging Configurations using our automatic installer.  In 
order to work with the Wasatch installer, you must gather all of the files associated with the new Imaging 
Configuration into a folder that is called “configurations” (case sensitive).  We recommend you put your 
working “configurations” folder in a temporary location for gathering the files, such as 
c:\temp\configurations.   

• Go to c:\wwrip\configurations and find the directory folder with the name of the printer model used in 
your profile.  You will notice that there are separate folders for each of that printer’s loaded Imaging 
Configuration within the printer folder.  For distribution, you need your new profile to be in a folder 
named precisely like this printer’s folder--case sensitive, including any spaces etc.)  For this reason, we 
recommend that you copy the entire folder named for that printer over to your temporary 
“configurations” folder and then delete the imaging configuration sub-folders other than the one you wish 
to distribute from the temporary location.   

• You can find the automatic installation tool on either of the Imaging Configuration CD’s provided with 
SoftRIP.  From the CD, copy “Install.exe” and the “Autorun.inf” informational text file to your temporary 
folder.  Note: the files Autorun.inf and Install.exe should be one level down from the configurations folder 
such as in the diagram below.   Now you can email or burn the new configurations to CD for distribution. 

 

 

CMYK and RGB 
Color Spaces 

Primary and 
Secondary colors 
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• At the distribution site the customer only needs to launch install.exe by double clicking, or if distributing 
by CD the Autorun file will automatically launch the installer when the customer inserts the CD.  The 
installer will ask for the location to copy the Imaging Configuration(s) to.  The primary wwrip folder 
should be selected (such as c:\wwrip).  The installer will list all Imaging Configurations that are in its 
same “configurations” folder by printer.   To install, a user only needs to check the boxes for the profiles 
desired.  A confirmation message will be shown with the number of profiles installed.  Click OK and Exit.    

• Your new profile will now appear in the user’s copy of SoftRIP. When the appropriate printer is selected 
in the setup screen, the new Imaging Configuration will appear along with others loaded in the Imaging 
Configuration window. 

C:\Temp 
  Install.exe 
  Autorun.inf 
  configurations\ 
   [Printer folder]\ 
    profile 


